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BASIC SETUP AND OPERATION

Start Up

1. From the Start menu, select Programs - NEC - Aspire PC Assistant, or double-click on the Aspire PC Assistant 
icon on the desktop. 

2. Log into the PC Assistant by entering your user ID/login and password, and select your extension from the drop-
down list of available extensions.

The user ID and password are set up in the User Profile in the Telephony 
Administration utility. Check with your communications manager for your log-in. 

Tour of the Main Menu

The main screen of the Aspire PC Assistant presents valuable information about the current call activity and provides easy 
access to the basic operations. Using either the mouse or keyboard, the user can quickly move between the different areas 
of the screen to dispatch callers, search the personal directory, and view the status of the individual lines.

Speed Dial List

Off Hook Indicator & 
ControlCall List

Lamp Indicator

File Menu Call Control

Screen Pop 
Application
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The main screen consists of the following areas:

● Call List
Maintains a history of call activity at the console. Allows easy access to previously dialed numbers. Also, 
once the desired telephone number has been entered into the call list, the Enter key can be used to initiate 
the outbound dial. 

● Lamp Indicator Area
Displays information about the current call, a queue of all calls currently active on the PC Assistant, and pro-
vides access to one click switching. By hovering the mouse over a specific lamp indicator, display informa-
tion is shown.

● Call Control Buttons
Provides shortcuts to commonly used functions on the telephone. 

● Speed Dial List
Lists frequently dialed numbers designated from within the Company Directory, Contact List, and Personal 
Directory.

● File Menu
Provides the standard windows controls and access to standard operations and utilities through the pull-
down menus.

● Screen Pop Application
If the Screen Pop is set to open contact when program button is clicked, the Contact Manager icon will 
appear here when the call is answered.
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File Menu Drop-Down Menus

The File Menu provides a series of drop-down menus, which list all of the functions available within a selected category. 
The functions available from the File Menu are as follows:

Preferences:

General

● Docked Edge – Choose where the PC Assistant application will appear on the Windows Desktop.

To change docking sides:

1. Click File - Preferences - General tab.
2. Select the location where you wish to have the Aspire PC Assistant docked (top, bottom, left, right).

3. Click OK. 

● Auto Hide Window – Choose whether the application will auto hide and if checked, choose whether the 
application will pop-up on incoming calls. 

To allow Auto Hide mode:

1. Click File - Preferences - General tab. 
2. Check the Auto Hide box to enable auto hiding. 
3. Click OK. 
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● E-Mail Integration – Enable/disable E-Mail Integration.

To allow E-Mail Integration:

1. Click File - Preferences - General tab. 
2. Check Enable E-Mail Integration to enable E-Mail integration with the Aspire PC Assistant, allowing 

you to send E-Mails through the Call Log, Contact list, Personal list, or Directory. 
3. Click OK. 

● Ringing – Choose whether to enable or disable ringing through the PC speakers.

To allow Ringing through Speakers:

1. Click File - Preferences - General tab. 
2. Check Enable ringing through PC speakers.

3. Click OK. 

● Confirm Exit – Choose whether or not a dialog is displayed when shutting down the PC Assistant. 

To enable/disable confirmation upon Exit:

1. Click File - Preferences - General tab. 
2. Check Show confirm dialog on exit to show the dialog or uncheck to disable it. 
3. Click OK. 

● Quick Message Client – Enable/disable the Quick Message Client, and enable/disable the notification tone 
when a Quick Message is received.

To allow Quick Messages:

1. Click File - Preferences - General tab. 
2. Check Enable Quick Message Client to enable the PC Attendant to send messages to the PC Assistant 

user. 
3. Check Enable Notification Tone to enable the PC Assistant’s PC to beep when a Quick Message is 

received from the PC Attendant. 
4. Click OK. 
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Directory

● Shortcuts to Directory – This section is used to determine how a call is handled with an active call when 
the Directory window is displayed. 

Select the operation for One-Touch Transfer:
This function requires the Directory window be displayed (click FILE-DIRECTORY).

1. Click File - Preferences - Directory tab. 
2. Click on the option desired when clicking on a busy Directory entry while on an active call - Super-

vised Transfer or Immediate (Blind) Transfer + click OK. 

Select the operation when double-clicking on a busy Directory entry:
This function requires the Directory window be displayed (click FILE-DIRECTORY). Refer 

to page 22, page 38, or page 38 for operational information.

1. Click File - Preferences - Directory tab. 
2. Click on the option desired when double-clicking on a busy Directory entry while on an active call - 

Send active call to voice mail, Place call on hold and initiate voice over, or Camp call on busy 
phone. 

3. Click OK. 

● Name Display for Directory – Select whether the Directory will display first then last name or last then first 
name.

Select the Name Display:
This function requires the Directory window be displayed (click FILE-DIRECTORY).

1. Click File - Preferences - Directory tab. 
2. Click on the option desired for view the Directory names - First Name, Last Name or Last Name, 

First Name + click OK. 
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Recording

Note: This option requires a CTU adapter be installed on the keyset which will be using 
the PC Assistant application. If the adapter is not recognized, the selections will be 
inactive.

● Compression Rate – Choose the compression rate for recordings.

● Recording Profile – Choose to record all calls, or if left unchecked, only the internal or external calls 
selected by the user will be recorded.
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Personal Greeting

● Enable Voice Greeting – Use this option to enable/disable the voice greeting to be played to the outside 
caller. If this feature is enabled, every external inbound call to the PC Assistant will play this pre-recorded 
greeting, once the call has been answered. This greeting can be recorded using the Windows Sound Recorder 
(requires a CTU installed on the digital keyset).

Note: This option requires a CTU adapter be installed on the keyset which will be using 
the PC Assistant application. If the adapter is not recognized, the Enable Voice 
Greeting check box will be inactive.

To enable the Personal Greeting:

1. Click File - Preferences - Personal Greeting tab. 
2. Click the Enable Voice Greeting check box. 
3. Under the File field, click the Browse button and find the file to be used as the greeting. 

Click the Play button to hear the greeting message.

4. Click OK. 
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Tool Buttons

● Available Tool Button – Use this feature to define the tool bar to your own liking (displaying desired icons 
and positioning them in the order needed) and change the Hot Key (Accelerator) functions to your preference. 

To change the hot key for a function:

1. Click File - Preferences - Tool Buttons tab. 
2. Click the function name under Tool Buttons. 
3. Edit the Accelerator field. 
4. Press OK. 

To change the order of the function:

1. Click File - Preferences - Tool Buttons tab. 
2. Click the function name under Tool Buttons. 
3. Edit the Move Up or Move Down buttons to place the function in order. 
4. Press OK.
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Screen Pop

● Contact Manager – Choose which Personal Information Manager the Aspire PC Assistant will integrate 
with to provide screen pops. If none are used, leave the "none" setting unchanged. This function allows an 
incoming number which is entered into the Contact Manager program to pop up on the screen when an 
incoming call is received on the PC Assistant. If multiple entries with the same telephone number are 
assigned in the Contact Manager, the first match found is displayed.

Compatible Contact Managers:
Microsoft Outlook 2000 or higher
ACT! 2005 or higher
Goldmine 6.7 or higher
CRM Plug-in (see below for details)

Prior versions will not work or may provide unexpected results.

CRM Plug-in is an optional customized Contact Manager interface. This should only be selected if a cus-
tomized Contact Manager plug-in has been created for your application.
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When using ACT! or Goldmine 6.7 or higher for the contact manager, the internal extension number 
field must be set in the Phone # field, not in the Extension field in order for station-to-station calls to pop. 
You may also need to change the phone number format to display the number without parenthesis. 

With the NEC Add-in for Outlook installed, or if using ACT! or GoldMine, these applications can be 
used for dialing out using the displayed contact. Refer to Placing a call using the Contact Manager, page 35 
after setting the Contact Manager to allow for outdialing. 

To enable Contact Manager:

1. Click File - Preferences - Screen Pop tab.

2. Check the Contact Manager you wish to use to integrate with the Aspire PC Assistant.
3. Click OK.
4. If Microsoft Outlook is used, click on the Settings button and select the Contacts folder to be used.

Note: With GoldMine, the application must be maximized in order for the Screen Pop 
information to be displayed. This may be changed in a future release.

● Activation – Choose when you want the screen pop to take place, i.e. when ringing, once the call has been 
answered, or manually use the program button to show the screen pop.

To access Contact Manager:

1. Click File - Preferences - Screen Pop tab.

2. Check the option for when the Contact Manager should appear - Open contact when ringing, Open 
contact when answered, or Click program button to open contact (this option will provide an icon 
next to the Call List which you can click to open the contact).

3. Click OK.
4. If Microsoft Outlook is used, click on the Settings button and select the Contacts folder to be used.

● Call Filter – Choose whether you want to show screen pops for all incoming external/internal calls or only 
external incoming calls.

To use Call Filter:

1. Click File - Preferences - Screen Pop tab.

2. Click the Open contact for all calls button to enable contacts popping up for all incoming calls.
- OR -
Click the Open contact for external calls only button to enable contacts popping up for all external 
calls only.

3. Click OK.
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Call Log:

Call Log
View inbound and outbound internal or external calls to and from the user. Other features include the capa-
bility to redial a number within the call log, replay a recording from within a call log record, delete/erase a 
record from the call log, EMail a call log record using the default EMail client, print all or part of the call 
log, and archive/save all or part of the call log to a designated file.

View
Use these settings to set the visibility of the columns which should appear in the Call Log. You can also set the 
size and location of each column and the entire Call Log can be sorted based upon any individual column.

● Type – Inbound or Outbound Call.

● Date – Date the call was made.

● Time – Time the call was initiated / received.

● User - The User ID of the person receiving/placing the call.

● Number – Telephone Number that was called / received.

● Name – Name of the party that was called, if the call was an inbound call, the Caller ID information 
will appear if the keyset is programmed to receive Caller ID on inbound calls.

● Duration – How long the call was in progress.

● Line – The trunk number that was used for the call.

● Note – Any comments entered by the user about the call. You can edit an existing note by right-clicking 
on the record and selecting the Edit Note function.

To change the visible columns within the Call Log Tab:

1. On the File menu, select the Call Log option. 
2. Select the View tab on the Set Visible Columns menu. 
3. Check each column that will be visible on the Call Log. 

4. Click OK to save the settings. 

To change the order of the columns in the Call Log Tab:

1. Position the mouse cursor within the heading of the column to be moved. 

2. Hold down the left mouse button and drag the column to the new position. 
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To change the width of a column in the Call Log Tab:

1. Position the mouse cursor within the heading and on the right edge of the column to be resized. When 
the mouse is in the proper position, the mouse cursor will change to a double-headed arrow. 

2. Hold down the left mouse button and drag the border of the column to the new width. 

To sort the contents of the Call Log Tab:

1. Position the mouse cursor within the heading of the column to use for sorting. 
2. Click the left mouse button to sort the Call Log in ascending order based upon the contents of the 

selected column. 
3. Clicking the left mouse button a second time will sort the Call Log in descending order.

Directory:
● Directory – View, edit, delete, or call a person entered in the Directory.

● Contacts – View, edit, delete, or call a person entered in the Contacts list.

● Personal – View, edit, delete, or call a person entered in the Personal contacts list.

Help:
Used to access Contents and Index or About Aspire PC Assistant.

Exit:
Used to close the Aspire PC Assistant application.
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Call Control

The Call Control buttons provide quick access to the most commonly used call processing and user functions. A feature 
can be selected by using the mouse to click on the desired function button or pressing the associated Function Key (F1 - 
F12; ALT F1 – ALT F12) on the keyboard (as assigned in the File - Preferences - Tool Buttons menu). Individual buttons 
in this area become disabled if the function is not allowed for the current state of the user’s keyset. For example, the 
Answer button is only enabled when a call is ringing the user’s keyset.

The functions available for the Call Control are described as follows. 

Answer an incoming call.

Transfer the current active call.

Disconnect the current active call.

Initiate a conference call, which includes the active call.

Start/stop recording of the current call.

Initiate a page using the telephone’s paging system.

Transfer the active call to a park location.

Retrieve a call from a designated park location.

Barge in on an extension who is active on a call.

Perform a call pickup at a ringing extension (Directed Call 
Pickup, Call Pickup, Other Group Call Pickup, or Specified 
Group Pickup).

Retrieve a call ringing a group using Group Call Pickup.

Redial one of the last numbers called.
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In addition to the Call Control icons, the following icons are also displayed in the PC Assistant window which can be used 
for call handling.

Voice over to an extension who is active on a call.

Set/cancel the Call Forward for the keyset.

Set/cancel the Do Not Disturb feature for the keyset.

Set/cancel the Background Music for the keyset.

Camp on to a busy extension or create a Callback for the 
extension.

Perform a call pickup at a ringing extension using Other 
Group Call Pickup.

Add a note for an active call which will be stored in the Call 
Log.

Use this button to view a drop-down list of all features.

Initiate an outbound call from the console.

Place an outside call on Hold. (Intercom calls cannot be 
placed on hold using the PC Assistant.)
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FEATURE OPERATION

Access More Functions

Access More Functions from the Call Control Section

A shortcut is provided in the Call Control section to access additional functions which may be hidden from view (depend-
ing on your screen resolution). 

To view all available Call Control functions using More icon:

1. This button ( ) provides a drop-down list of all functions.
Functions that are grayed out represent functions that are not currently available during the state of the 

phone.
Answer Incoming Calls

Answer Incoming Calls

When a call rings your phone, the Aspire PC Assistant generates a notification tone and adds a new Ringing entry to the 
Lamp Indicator Area. The Assistant can answer the call using any of the following methods.

1. Click the Answer icon ( ) OR press the assigned hot key on the keyboard (F1) OR use the mouse to select the 

Ringing call entry within the Lamp Indicator Area. 
When an inbound call is answered, the state of the call will change from Ringing to Active on the Active 

Lamp Indicator Area.

If the user has another active call when a ringing call is answered, the active call will automatically be 
placed on hold.

To disconnect from the active call:

1. Click the Hang Up icon ( ) OR press the assigned hot key (F4) on the keyboard.

When an active call is disconnected, the call entry will be removed from the Lamp Indicator Area.

Automatic Voice Greetings

Automatic Voice Greetings

The PC Assistant is capable of playing a personalized greeting for every outside call answered by the PC Assistant appli-
cation. The greetings are from a pre-recorded file, created in the user’s own voice. When an incoming external call is 
answered, the PC Assistant will automatically play the voice file - both the caller and user can hear the greeting. This 
option is configurable per user, so that each user can use their own recorded file or disable the playback option. This fea-
ture can be used to present a professional appearance to customers by delivering an accurate and consistent greeting with 
each call.

The ability to play a personal greeting requires that a CTI device (CTU Adapter, P/N 0890059) be installed on the 
PC Assistant’s keyset telephone. The Personal Greeting features will not be enabled if this device and the associated 
device drivers are not installed on the PC.

To setup a personal greeting:

1. Record a greeting using a utility such as the Windows Sound Recorder and save the file on the PC Assistant PC.

2. On the Tools menu, select Preferences .

3. Select the Personal Greeting tab on the Preferences menu + select Enable Voice Greeting.

4. Specify the name of the recording to be used or press the Browse button to select a file + OK.

Background Music
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Background Music

Background Music (BGM) sends music from a customer-provided music source to speakers in the keysets. If an extension 
user activates it, BGM plays whenever the user’s extension is idle.

To enable/disable background music using the Background Music function:

1. Click the Background Music icon ( ) OR press the assigned hot key on the keyboard (ALT-F4).

If music is enabled, ‘BGM on’ will appear on the telephone display and begin to play music over the tele-
phone speaker when the phone is idle. 

If music is disabled, ’BGM off’ will appear on the phone display and stop playing music over the tele-
phone speaker when the telephone is idle.

Barge-In

Barge-In

Barge In permits an extension user to break into another extension user’s established call, including Conference Calls. 
This sets up a Conference-type conversation between the intruding extension and the parties on the initial call. With Barge 
In, an extension user can get a message through to a busy co-worker right away.

There are two Barge In modes: Monitor Mode (Silent Monitor) and Speech Mode. With Monitor Mode, the caller Barging 
In can listen to another user’s conversation but cannot participate. With Speech Mode, the caller Barging In can listen and 
join another user’s conversation. This setting is based on the Aspire system programming.

To Barge in on a conversation using the Barge In function:

1. Select the Barge In icon ( )  OR press the assigned hot key on the keyboard (ALT-F3).

2. Enter in the extension number of the busy extension + select Start to interrupt (become part of) the conversation of 
another internal user. 
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Call Forwarding

Call Forwarding

Call Forwarding permits an extension user to redirect their calls to another extension. Call Forwarding ensures that the 
user’s calls are covered when they are away from their work area. The types of Call Forwarding are:

● Call Forwarding When Busy or Not Answered
Calls to the extension forward when busy or not answered.

● Call Forwarding Immediate
All calls forward immediately to the destination, and only the destination rings.

● Call Forwarding When Not Answered
Calls forward only if they are unanswered (Ring No Answer).

● Call Forwarding Immediate with Ringing
All calls forward immediately to the destination, and both the destination and the PC Assistant extension 
rings.

Call Forwarding will reroute calls ringing an extension, including calls transferred from another extension. The extension 
user must enable Call Forwarding from their phone. 

To forward the PC Assistant Extension:

1. Select the Call Forward icon ( ) OR press the assigned hot key on the keyboard (ALT-F7).

2. Select the forwarding mode in the Forwarding On field. 

● Busy or Not Answered
● Immediate
● Not Answered
● Immediate with Ringing
● Busy

3. Enter/select the destination number in the Destination field + select Start to set the call forward setting.

To cancel the Call Forwarding:

1. Select the Call Forward icon ( ) OR press the assigned hot key on the keyboard (ALT-F7).

2. In the Call Forward window, select Cancel Call Forward.

3. If more than one forwarding mode has been set, in the Forwarding Mode field, select the forwarding mode to be 
cancelled.

4. Select Start to cancel the call forward setting.

Call Log
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Call Log

The Aspire PC Assistant maintains a Call Log, which provides a historical trace of the assistant’s call activity. Each 
inbound and outbound call generates a record in the call log. This information can be used to retrieve details about specific 
calls and perform functions such as re-dialing a previous call or playing back a recorded telephone conversation. 

Each call record includes the user ID, call type (inbound/outbound), call date and time, caller identification, call duration, 
line appearance, and any notes entered for the call. From this table, the user can sort the entire list based upon any individ-
ual column. The user also has the ability to delete or archive the call log, as well as print the contents.

The columns within the Call Log tab can be resized and rearranged. To resize a column, place the mouse cursor within the 
header row, on the right hand edge of the column to be resized. Hold down the left mouse button and drag the edge of the 
column to the new size. To rearrange the order of the columns, place the mouse cursor within the header row of the col-
umn to be moved. Hold down the left mouse button and drag the column into the new position.

To access the Call Log:

1. From the PC Assistant’s main window, select File - Call Log. 

Re-dialing a Number from the Call Log

1. Double-click a call log entry to automatically redial the specified number.  OR  Select the Call Log record to be 
redialed + press the right mouse button + select Dial from the pop-up menu.

A call cannot be dialed if there is an internal call on hold.

Playing Back a Recorded Telephone Conversation
The Record function is used to capture a telephone conversation from the PC Assistant’s keyset and save the recording on 
the PC. The recording is attached to the Call Log record and indicated by the recording icon

( ) within the Type field.
 

To playback a recording:

1. Press the right mouse button to select the Call Log record that contains the recording.

2. Select Play. The Playback window will open and the recording will automatically start playing.
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The Playback window provides the following controls:

Deleting Records from the Call Log

To delete a single Call Log record:

1. Select the Call Log record that is to be deleted by clicking on it with the right mouse button + select Delete.  OR 
Highlight the Call Log record to be deleted and from the Call Log drop-down menu, select the Delete option.

To delete a block of Call Log records:

1. Highlight the records to be deleted using the shift/control keys.

2. Press the right mouse button within the highlighted block. From the pop-up menu, select the Delete option.
- OR -

From the Call Log drop-down menu, select the Delete option.

Sending a Call Log Record or Recording Using EMail

To send a call log record or recording using EMail:

1. Press the right mouse button to select the Call Log record to be sent.

2. From the pop-up menu, select the EMail option. This will create a new mail message using your default EMail cli-
ent, with the call log detail and any call notes included in the body of the message. If a recording is associated with 
the call log record, then the sound file for the recording will be attached to the message.

Printing the Call Log
The PC Assistant provides the capability to print all or part of the call history. Options are also provided which allow the 
format of the call log to be modified for printing.

To print the entire Call Log:

1. From the Call Log menu, select the Print option, followed by Print All.
- OR -

Right mouse click within the highlighted block. From the pop-up menu, select the Print option, followed by 
Print All.

2. Specify the destination printer and then click OK.

Slider bar - advances as the playback progresses. Dragging the 
slider will change the current playback position within the 
recording.

Play: Start/resume playback of the recording.

Pause: Suspend playback at the current position.

Stop: Suspend playback and set the current position to the 
beginning of the recording.
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To print selected records from the Call Log:

1. Highlight the records to be printed.

2. From the Call History menu, select the Print option, followed by Print Selected. 
- OR -

Right mouse click within the highlighted block. From the pop-up menu, select the Print option, followed by 
Print Selected.

3. Specify the destination printer + click OK.

Editing a Call’s Note Entry
If a call has a note entry stored with it, the entry can be modified from the Call Log view.

To Edit a Note within the Call Log tab:

1. Right-click on the record and select Edit Note.
The previously entered information is displayed.

2. Edit the information as needed + click OK. OR  Click Clear to remove the entry.

Changing the Call Log Layout
The PC Assistant provides several options to change the layout of the Call Log. The size and location of each column can be 
modified and the entire Call Log can be sorted based upon any individual column.

To change the visible columns within the Call Log tab:

1. On the View menu within the Call Log window, select the Set Visible Columns option + check each column that 
will be visible on the Call Log + press OK.

To change the order of the columns in the Call Log:

1. Position the mouse cursor within the heading of the column to be moved + hold down the left mouse button and 
drag the column to the new position.

To change the width of a column in the Call Log:

1. Position the mouse cursor within the heading and on the right edge of the column to be resized. When the mouse is 
in the proper position, the mouse cursor will change to a double-headed arrow.

2. Hold down the left mouse button and drag the border of the column to the new width.

To change the print options of the Call Log:

1. To change the paper size, orientation of the printed output, or margins, on the Call Log menu of the Call Log 

screen, select Call Log - Print - Page Setup. Select the required options + click OK. 

To sort the contents of the Call Log:

1. Position the mouse cursor within the heading of the column to use for sorting.

2. Press the left mouse button to sort the Call Log in ascending order based upon the contents of the selected column.

3. Pressing the left mouse button a second time will sort the Call Log in descending order.



FEATURE OPERATION

Aspire PC Assistant User Guide ◆ 21

Archiving the Call Log
Regular maintenance of the Aspire PC Assistant should include archiving of the Call Log. This operation is beneficial for 
reducing the number of call records displayed within the application, and therefore, improving access when searching for 
individual records. The archival process also provides a method of backing up the call history and storing the records off-
line for future access.

The archive operation saves the call history to a file using Comma Separated Values (CSV) format. This format can be 
viewed using a standard text editor or easily imported into a database or spreadsheet program. During the archive opera-
tion, the user can specify if the recorded files are to be saved or deleted. If the recorded files are saved, they will be com-
pressed into a zip file, with the same file name as the archived call records.

To archive the Call Log:

1. From the Call Log menu, select Archive. This will open the Call Log Archive menu.

2. Select the Start Date and End Date for the archive. All call log records within this range of dates will be included 
in the archive and removed from the Call Log tab.

3. Select either Save in corresponding.zip to keep the recordings or Delete Recordings to erase the recordings. If a 
zip file is selected, the name of the zip file will be the same as the archive file name selected in the next step with a 
.ZIP extension.

For example, if ARCHIVE_OCT.CSV is selected for the archive file, the zip file will be 
ARCHIVE_OCT.ZIP.

4. Enter the name of the archive file to be created or use the Browse button to select the file and/or location + press 
Save.

5. Click Archive to create the archive file.

Call Recording

Call Recording

You may occasionally have a need to record telephone conversations. The PC Assistant provides the ability to record 
active calls and save the recordings as standard sound files on the PC hard drive. Each recorded file is associated with a 
record in the call log, providing easy access for retrieval of the recordings. From within the application, the user can 
choose to playback the call recordings, archive to another file/disk, or EMail to another user. You have the option to con-
figure the software to automatically record every call or manually start/stop recording for individual calls.

The user must have the CTU TAPI adapter installed in their phone and properly configured for this function to operate 
successfully.

Note: If the CTU adapter’s connection is lost and then recovered at any point while the PC Assistant is running, the 
“Record” function will not work correctly until the PC Assistant is restarted.
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Recording the Active Call

The Aspire PC Assistant provides the ability to record the active call and save the recording as a file on the PC. This file 
can then be played back within the application or EMailed as a WAV file to another user. Recordings are associated with 
individual entries in the Call Log and can be accessed under File - Call Log.

The ability to record calls requires that a CTU device be installed in the PC Assistant telephone. 
The Recording features will not be enabled if this device and the associated device drivers are not 
installed on the PC.

When placing an intercom call to an extension, the called party must pick up their handset or 
press the SPK key in order for the Call Recording to start.

To start recording a call:

1. Click the Record icon ( )  OR press the assigned hot key (F8) on the keyboard.

 When a call is being recorded, the label on the Record button will change to Stop on the Function Tool-
bar.

To stop a recording:

1. Select Stop  OR Press the assigned hot key (F8) on the keyboard.
 If recording is stopped and restarted on the same call, the individually recorded sessions will be com-

bined into a single file.
 If a call that is being recorded is placed on hold, the recording will automatically be restarted when the 

call is retrieved from hold.

To automatically record all calls:

1. On the File menu, select the Preferences option.

2. Select the Recording tab on the Preferences menu + click Compression Rate + click Record All Calls + click 
OK.

Camp On

Camp On

With Camp On, an extension user may call a busy extension and wait in line without hanging up. When the user Camps 
On, the system signals the busy extension with two beeps indicating the waiting call. The call goes through when the busy 
extension becomes free. Camp On helps busy extension users know when they have additional waiting calls. It also lets 
callers wait in line for a busy extension without being forgotten.

To Camp On to a busy extension:

1. After calling a busy extension, click on the Auto-Callback icon ( )  OR press the assigned hot key (Ctrl + 

F7) on the keyboard.

2. Once the called extension becomes free, the call will automatically ring the extension.
If you hang up before the call connects, the Camp On is changed to a Callback. Once the called extension 

user hangs up, the PC Assistant will ring and, once it’s answered, the originally called extension will ring.

-OR-
1. With the Directory window displayed (click File-Directory), double-click on the busy extension (indicated by a 

red bullet to the left of the name).
For this shortcut to be enabled, the File-Preferences-Directory menu must have the Camp call on busy 

phone option selected as the current double-click action.

Conference
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Conference

Conference lets an extension user add additional inside and outside callers to their conversation. With Conference, a user 
may set up a multiple-party telephone meeting without leaving the office. The Aspire system allows an extension user to 
Conference up to 31 internal and/or external parties together (the originator would be the 32nd party reaching the maxi-
mum of 32). 

With an active call, the Aspire PC Assistant can establish a conference between the caller, assistant, and a third party using 
either the Conference function or the Directory menu. 

Setting Up a Conference Call:

1. Click the Conference icon ( ) OR press the assigned hot key on the keyboard (F6).

2. Enter the telephone number of the conference party into the Destination field within the Conference menu.

3. Select the Start option within the Conference menu to initiate the conference.

4. When the destination answers, announce the conference + select Complete. If the destination does not answer or 
does not want to participate in the conference, select Disconnect.

5. To add additional parties, repeat the above steps.
As long as there is one other internal party connected in the Conference, the PC Attendant can click 

Hangup to exit the Conference and the other parties can continue to talk.

To initiate a conference using the Directory tab:

1. Use the right mouse button to select the directory entry to be added to the Conference.

2. On the pop-up menu, select the Conference option to initiate the Conference.

3. When the destination answers, announce the conference + select Complete. If the destination does not answer or 
does not want to participate in the conference, select Disconnect.

4. To add additional parties, repeat the above steps.
As long as there is one other internal party connected in the Conference, the PC Assistant user can click 

Hangup to exit the Conference and the other parties can continue to talk.

Directed Call Pickup

Directed Call Pickup

This option also provides access to Group Call Pickup, Pickup Other Group, and Call Pickup Specific 
Group features. You can also access these features directly. Refer to Group Call Pickup, page 31.

Directed Call Pickup permits an extension user to intercept a call ringing another extension. This allows a user to conve-
niently answer a co-worker’s call from their own telephone. With Directed Call Pickup, an extension user can pick up: 
trunks calls, Direct Inward Lines (DIL), transferred trunk calls, transferred Intercom calls, ringing and voice-announced 
Intercom calls.
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The Group Call Pickup, Pickup Other Group, and Call Pickup Specific Group features allow a user to answer a call ring-
ing an extension in a Pickup Group. This permits co-worker’s in the same work area to easily answer each other’s calls.

Using Directed Call Pickup to Answer a Ringing Call

1. With the telephone idle (no active call), click the Directed Call Pickup icon ( )  OR press the assigned hot 

key on the keyboard (ALT-F11).

2. Select the Pickup Type (Direct Station Pickup, Group Call Pickup, Pickup Other Group, Call Pickup Specific 
Group) from the drop-down list. 

3. With Directed Call Pickup: Enter the extension number of the ringing extension to be answered.
With Call Pickup Specific Group: Enter the group number to be answered.

4. Click Start to retrieve the call from the location. 
Only Pickup Types that are defined in the TAPI Feature codes tab (File - Telephony - Telephony Configu-

ration - Feature Codes) will be listed under Pickup Types.

Directory / Contact List

Directory / Contact List

The Aspire PC Assistant provides a personal directory to assist in handling call activity. Each contact person can be 
entered into the directory to provide the user with quick access to contact information and an easy method to send calls. 

Different directories for internal (Directory) and external (Contacts) numbers are available. The internal directory serves 
as the company directory and includes all employees' names, extensions, EMail, department, alternate numbers, and a 
BLF indication for the extension. The external directory serves as an on-line phone/address book for frequently dialed 
external numbers. If the telephone number of an incoming caller is entered in the Contact List, the name entered will be 
displayed in the Call Control panel for the incoming call.

The Directory and Contact List are maintained on the PC running the CTI Service and can be viewed by any PC Attendant 
or PC Assistant user. The Telephony Administrator utility also has the ability to view and edit the contents of the Directory 
and Contact List databases.

Individual clients (PC Attendant and PC Assistant users) can also edit the contents of the Directory and Contact List if 
they are given that privilege. Separate privileges to edit the Directory and Contact List are controlled through the individ-
ual User profile, as defined within Telephony Administrator. 

The user views the directory by clicking the Directory option from the File menu. The directory/contact list is opened in a 
separate window - select either the Directory or Contacts icon on the left of the window to view the listing. Each listing 
provides a search box for quickly searching for a name. The convenient search capability can be used to find individuals 
by first name, last name, or partial name. Entering alphabetic characters in the Search field will filter the displayed entries 
using the name fields. If a user enters 'B', then all of the directory listings that have the first name starting with B will be 
displayed. Entering 'B  D' will further filter those entries to only show the listings with a first name starting with B and a 
last name starting with D. Filtering by last names only can be accomplished by entering a space followed by the characters 
in the last name. 
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The Directory can also be used to initiate a call by double-clicking on any entry in the directory or contact list.

Each entry in the Directory database can contain the following fields:

● First Name 

● Last Name 

● Extension 

● Title 

● EMail address 

● Location 

● Department 

● Supervisor Name 

● Supervisor Telephone Number 

● Assistant Name 

● Assistant Telephone Number 

● Alternate Contact Numbers

● Notes

● Ability to Hide the Directory Entry or Hide the BLF Button

Each entry in the Contact database can contain the following fields:

● First Name 

● Last Name 

● Telephone 

● Title 

● EMail address 

● Company Name 

● Company Dress 

● Alternate Contact Numbers

● Notes

Operations that can be performed on the Directory/Contact List include the following:

● Adding a new entry to the Directory/Contact List

● Modifying an entry in the Directory/Contact List

● Deleting an entry from the Directory/Contact List

● Searching the Directory/Contact List

● Printing the Directory/Contact List

● Changing the Directory/Contact List Tab Layout

● Call Handling within the Directory/Contact List

● BLF displays for extensions within the Directory

● Sending a message from the Directory/Contact List

The columns within the Directory and Contacts list can be resized and rearranged. To resize a column, place the mouse 
cursor within the header row, on the right hand edge of the column to be resized. Hold down the left mouse button and 
drag the edge of the column to the new size. To rearrange the order of the columns, place the mouse cursor within the 
header row of the column to be moved. Hold down the left mouse button for a second or two until the cursor changes from 
an arrow to an arrow with a square, then drag the column into the new position.

The data can be sorted by name, number, or department name. Simply click in the header row of the column which should 
be used for the sort process.
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An import utility is provided with the Contacts listing that allows databases from third-party applications to be inserted into 
the console directory. The import utility requires that the import file be a CSV (comma-separated values) file. In the PC 
Assistant, you must map the fields within the CSV file to the corresponding fields within the application. When importing 
data, the “Personal” directory will be displayed only to the user importing the information. Importing to the “Contacts” list 
will display the information to everyone using the PC Assistant, PC Attendant, and Telephony Administrator. The data from 
the PC Assistant’s Contacts listing can be exported to a CSV format as well. 

NOTE: Only authorized users have the ability to modify the Directory. This must be allowed in 
the Telephone Administrator.

To add a new entry to the Directory:

1. Click File-Directory to open the Directory/Contact List window.

2. If not already selected, click on the Directory icon on the left-hand side of the window.

3. On the File menu within the Directory window, select New Entry OR click the New icon + select New Entry.

4. Enter the appropriate data in the designated text fields. 
To enter an alternate number, select New in the Alternate Number area, and enter the telephone number 

and type. 

If a Department name is to be used, make sure to create the Department prior to creating a new Directory 
entry.

5. Click OK to add the new entry to the Directory and exit the Directory Maintenance menu.  OR If multiple new 
entries are being added, click Add to save the new entry and clear the form for the next new entry.

To add a new Department to the Directory:

1. Click File-Directory to open the Directory/Contact List window.

2. If not already selected, click on the Directory icon on the left-hand side of the window.

3. On the File menu within the Directory window, click Departments + click New. OR Click the New icon + select 
New Department.

A Department must first be added here before it can be entered in a new Directory entry.

4. Enter the name of the department + click OK. 

To modify a directory entry:

1. Highlight the directory entry to be modified. From the File menu, select Properties. 

2. Update the fields by entering new data in the appropriate text boxes. 
Quick Message is available only to those extensions whose properties are not indicated as “Hidden” in 

the Telephony Administrator’s Directory tab. 

Using the Notes option within the Directory, users can advise other PC Assistant or PC Attendant user’s 
of their status. For example, a user can enter a note for their extension such as “Out of the office until Mon-
day”. Anyone then displaying the Directory will be able to see this note for that extension. In addition, for the 
PC Attendant users, hovering over an extension with a note will display the text in a balloon window. The 
ability to edit the Directory must be allowed in the Telephony Administrator for the extension. 

3. To modify an Alternate Number, double-click within the Number field of the Alternate Number to be entered. 
Modify the contents of the Number field. 

4. Click on Save. 

To delete a single directory entry:

1. Select the directory entry with a right-mouse click + select Delete. OR Highlight the directory entry and from the File 
menu + select the Delete option. 
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To delete a block of directory entries:

1. Highlight the entries to be deleted. 

2. Right-mouse click within the highlighted block + select the Delete option. OR From the File menu, select the Delete 
option.

Searching the Directory and Contact/Personal Lists
The Directory, Contact List, and Personal List menus includes a Search function, which allows the attendant to query the 
listings. The Search capability can be used to find matching entries based upon first name, last name, or a combination of 
first and last name. Partial names can also be entered to find multiple entries that match the search criteria. 

To access the Search capability:

1. Click inside the Search field and enter the search criteria. 

To search for entries that match on either first or last name:

1. Enter the full or partial search string in the Search field. 
Example: Entering “John” will list all entries with first names of John and Johnny, as well as entries with 

last names such as Johnson.

To search for entries that match a full or partial first and last name:

1. Enter the first name, followed by a space, followed by the last name in the Search field. 
Example: Entering “John Stevens” will list John Stevens and Johnny Stevenson.

Example: Entering “S T” will list all entries whose first name starts with S and last name starts with T.

To search for entries that match only the last name:

1. Enter a space as the first character in the Search field, followed by the full or partial last name. 
Example: Entering “T” will list all entries whose last name starts with T.

To Clear the Search results:

1. Delete all the characters in the Search field OR press the Esc key on the keyboard while the cursor is in the Search 
field. 

Printing the Directory or Contact/Personal List

To print the entire directory:

1. From the File menu, select the Print option + Print All. This will cause the entire directory to be sent to the default 
printer. 

To print selected entries from the Directory:

1. Highlight the entries to be printed. 

2. From the File menu, select the Print option + Print Selected. This will cause the selected directory entries to be 
sent to the default printer. 
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Changing the Directory/Contact/Personal List Layout
Several options are provided for changing the layout of the Directory, Contact List and Personal List. The size and loca-
tion of each column can be modified and the entire Directory can be sorted based upon any individual column.

To change the visible columns within the Directory/Contact/Personal List:

1. On the View menu, select Set Visible Columns + check each column that will be visible on the Directory + click 
OK. 

To change the order of the columns in the Directory/Contact/Personal List:

1. Position the mouse cursor within the heading of the column to be moved. 

2. Hold down the left mouse button and drag the column to the new position. 

To change the width of a column in the Directory/Contact/Personal List:

1. Position the mouse cursor within the heading and on the right edge of the column to be resized. When the mouse is 
in the proper position, the mouse cursor will change to a double-headed arrow. 

2. Hold down the left mouse button and drag the border of the column to the new width. 

To sort the contents of the Directory/Contact/Personal List:

1. Position the mouse cursor within the heading of the column to use for sorting. 

2. Press the left mouse button to sort the list in ascending order based upon the contents of the selected column. 

3. Pressing the left mouse button a second time will sort the directory in descending order. 

Call Handling within the Directory/Contact/Personal List
Several common call handling functions can be accessed within the Directory, Contact List and Personal List. 

NOTE: The call handling functions are not available when the Directory, Contact List or Personal List window is opened 
from the Telephony Administrator.

A BLF indication is provided for each extension within the Directory list. The LED colors represent IDLE 
(gray), BUSY (dark green), RINGING (light green), DND (red) and FORWARD (blue).

To dial a number within a Directory/Contact/Personal List entry:

1. Double-click on the specific entry to be dialed. OR Press the right mouse button to select the directory entry to be 
dialed + select the Dial option. 

If there is an internal call on hold, another call cannot be dialed.

Using the Notes option within the Directory, users can advise other PC Assistant or PC Attendant user’s 
of their status. For example, a user can enter a note for their extension such as “Out of the office until Mon-
day”. Anyone then displaying the Directory will be able to see this note for that extension. In addition, for the 
PC Attendant users, hovering over an extension with a note will display the text in a balloon window. The 
ability to edit the Directory must be allowed in the Telephony Administrator for the extension. 

To leave a message in a Voice Mailbox:

1. Press the right mouse button to select the directory entry. 

2. From the pop-up menu, select the Voice Mail option. 
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To initiate a supervised transfer to a Directory/Contact/Personal List entry:

1. Press the right mouse button to select the directory entry to receive the call. 

2. From the pop-up menu, select the Transfer - Supervised option. 

3. When the party answers, announce the transfer, and then press the Complete button on the Transfer menu. 

4. If the destination does not answer or does not want to receive the transfer, press the Disconnect button to reconnect 
to the original caller. 

To initiate an unsupervised (blind) transfer to a Directory/Contact/Personal List entry:

1. Press the right mouse button to select the directory entry to receive the call. 

2. From the pop-up menu, select the Transfer - Immediate option. 

To initiate a conference with a Directory/Contact/Personal List entry:

1. Press the right mouse button to select the directory entry to add to the conference.

2. From the pop-up menu, select the Conference option. 

3. When the party answers, announce the conference + click the Complete button. 

4. If the destination does not answer or does not want to join the conference, press the Disconnect button. 

Sending a Message from the Directory
The Directory tab provides functions to generate EMails and voice mail messages to individuals in the company directory.

To send an EMail to a directory entry:

1. Press the right mouse button to select the directory entry + select the EMail option. This will create a new mail 
message using your default EMail client, with the destination set to the EMail address of the selected directory 
entry. 

To leave a message in a Voice Mailbox:

1. Press the right mouse button to select the directory entry + select the Voice Mail option. 

Adding a new entry to the Contact/Personal List

To add a new entry to the Contact/Personal List:

1. Click File-Directory to open the Directory/Contact List window.

2. If not already selected, click on the Contact or Personal icon on the left-hand side of the 
window.

3. On the File menu, select New Entry + enter the appropriate data in the designated text fields. 

4. To enter an alternate number, select New in the Alternate Number area, and enter the telephone number and type. 

5. Click OK to add the new entry and exit the Contact Maintenance menu. 

To add a new Company to the Contact/Personal List:

1. Click File-Directory to open the Directory/Contact List window.

2. On the File menu, click New Company. 

3. Enter the name of the company and click OK. 



FEATURE OPERATION

30 ◆ Aspire PC Assistant User Guide

Modifying an entry in the Contact/Personal List

To modify a list entry:

1. Highlight the list entry to be modified. From the File menu, select Properties. 

2. Update the fields by entering new data in the appropriate text boxes. 

3. To modify an Alternate Number, double-click within the Number field of the Alternate Number to be entered. 
Modify the contents of the Number field. 

4. Click OK.

Deleting an entry from the Contact/Personal List

To delete a single list entry:

1. Select the list entry with a right-mouse click. Click Delete. OR Highlight the list entry and from the File menu 
select the Delete option. 

To delete a block of list entries:

2. Highlight the entries to be deleted. 

3. Right-mouse click within the highlighted block + click Delete. OR From the File menu, click Delete.

Importing a .CSV File to the Contact/Personal List

To import data to either the Contact List or Personal List:

1. Select the list to which the import will be performed - Contacts or Personal.
Imports to the Contact List are displayed to everyone using PC Assistant, PC Attendant, or the Telephony 

Administrator. Imports to the Personal List are displayed only to the person performing the import.

2. From the File menu, select Import. + browse to the location of the .CSV file to be imported + click Next.

3. Select an item in the “Text Field” which should be imported (the information displayed is pulled from the columns 
in the .CSV file). Click on the Change Mapping button. 

4. From the drop-down list, select the location where the selected item should be imported. 
For example, “First Name” maps to “First Name”, “Last Name” maps to “Last Name”, “Business 

Phone” maps to “Primary Number”, etc.

5. Click OK + Finish.

6. A window displays how many entries were imported. Click OK. 

7. Review the items to ensure proper mapping.

Do Not Disturb

Do Not Disturb

Do Not Disturb blocks incoming calls and Paging announcements. DND permits an extension user to work by the phone undis-
turbed by incoming calls and announcements. The user can activate DND only while their phone is idle. Once activated, incom-
ing trunk calls still flash the line keys. The user may use the phone in the normal manner for placing and processing calls.

There are four Do Not Disturb options available:

● All Calls

● Outside Calls

● Paging/Intercom/Call Forwards/Transfers

● Call Forwards
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To activate DND for the PC Assistant phone:

1. With the PC Assistant telephone in an idle state (no active call), click the Do Not Disturb icon ( ) OR press 
the assigned hot key on the keyboard (ALT-F1). 

2. Select the condition for allowing calls to ring the PC Assistant’s keyset + click Start.

To cancel DND on the attendant console:

1. Click the Do Not Disturb icon ( ) OR press the assigned hot key on the keyboard (ALT-F1).

2. In the Do Not Disturb window, select Cancel Do Not Disturb + click Start.

EMail

EMail

The Contact and Personal Lists provide the ability to generate an EMail to the defined EMail address in the entry. The 
EMail Integration option must be enabled in the Preferences-General section

To send an EMail Using a Contact/Personal List Entry:

1. Click File-Directory to open the Directory/Contact List window.

2. If not already selected, click on the Contacts or Personal icon on the left-hand side of the window.

3. Press the right mouse button to select the desired entry to be EMailed + select the EMail option. This will create a 
new mail message using your default EMail client, with the destination set to the EMail address of the selected entry. 

The EMail address field within the Contacts or Personal entry for this extension must be filled in for this 
function to be enabled.

Group Call Pickup

Group Call Pickup

Directed Call Pickup can also provides access to Directed Call Pickup, Group Call Pickup, Pickup Other 
Group, and Call Pickup Specific Group features. Refer to Do Not Disturb, page 30.

Group Call Pickup allows you to answer a call ringing an extension in a Pickup Group. This permits co-workers in the same 
work area to easily answer each other’s calls. With Group Call Pickup, a user can intrcept the following types of calls:

● A call ringing the user’s own pickup group

● A call ringing another pickup group when the user doesn’t know the group number

Using Group Call Pickup to Answer a Ringing Call

You can use this option to answer a call ringing another extension within your group .

1. With the telephone idle (no active call), click either the Group Call Pickup icon ( ) OR press the assigned 

hot key on the keyboard (ALT-F12).
The ringing extension in the group is answered.
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Using Pickup Other Group to Answer a Ringing Call

You can use this option to answer a call ringing another group when you don’t know the group number.

1. With the telephone idle (no active call), use the mouse to select either the Pickup Other Group  function ( ) 

in the Call Control section. 
- OR -

Press the assigned hot key on the keyboard (ALT-F8).

2. The ringing extension in the group is answered.

Hold

Hold

Hold lets an extension user put a call in a temporary waiting state. The caller on Hold hears silence or Music on Hold, not 
conversation in the extension user’s work area. While the call waits on Hold, the extension user may process calls or use a 
system feature. Calls left on Hold too long recall the PC Assistant. 

To place the active call on hold:

1. Click the Hold icon ( ) OR press the F2 key on the keyboard.
Intercom calls cannot be placed on hold due to TAPI issues. You can, however, Park the call in order to 

answer another call. You can also use Transfer or Conference with intercom calls.

Outside calls will be placed into the first available Park. This is required due to the TAPI 2 commands and 
implementation.

When a call is placed on hold, the status of the call in the Active Call LED will change from Active (green) to On Hold 
(yellow) for intercom calls or placed in Park for outside calls.

To retrieve a call that was previously placed on hold:

1. Click the Yellow call icon ( ) within the Active Call List.
When a held call is retrieved, the status of the call in the Active Call LED will change from On Hold (yel-

low) to Active (red). If another call is active on the PC Assistant when a held call is retrieved, the active call 
will automatically be placed on hold.

Last Number Redial

Last Number Redial

Last Number Redial allows an extension user to quikly redial the last number dialed. For example, a usr may quickly 
recall a busy or unanswered number without manually dialing the digits.

To dial using Last Number Redial:

1. When placing an outgoing call, if the called party is busy/no answer, click the Last Number Redial icon ( ) 

OR press the assigned hot key on the keyboard (ALT-F8).
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Paging

Paging

Paging allows a user to locate another employee or make an announcement without calling each extension individually.

Internal Paging
Internal Paging lets extension users broadcast announcements to other keyset users. When a user makes a Zone Paging 
announcement, the announcement broadcasts to all idle extensions in the zone dialed. With All Call Paging, the announce-
ment broadcasts to all idle extensions programmed to receive All Call Paging. An extension can be a member of only one 
Internal Paging Zone. 

The Telephony Administrator must be used to determine whether 1-digit or 2-digit internal page zones are used. This must 
be set to match the Aspire system. 

External Paging
With External Paging, a user can broadcast announcements over paging equipment connected to external Paging zones. 
When a user pages on of these external zones, the system broadcasts the announcement over the speakers.

The Aspire S system allows up to eight External Paging zones. The Aspire system allows up to nine External Paging 
zones, with the additional zone (#9) provided on the NTCPU. All other zones (#1-8) requires a port on a 2PGDAD mod-
ule. In addition, each external zone has an associated relay contact. When a user pages to a zone, the corresponding con-
tact activates (closes). This provides for Paging amplifier control. Refer to the Aspire S or Aspire system hardware manual 
for additional details.

Combined Paging 
Use Combined Paging when you want to simultaneously Page into an internal and corresponding external zone. For exam-
ple, you can Page your company’s warehouse and outside loading dock at the same time. Combined Paging is available 
for Paging zones 1-8 and All Call. Optionally, you can change the Combined Paging assignments. For example, in the 
Aspire system programming, you can associate External Paging Zone 1 with Internal Paging Zone 4. When an All Call 
Combined Page is made, it will include both the external zones and the assigned internal zone(s). If the internal page zone 
is busy or there are no extensions in a page group, the announcement will be made on the external zones only.

Displaying Internal Page Zones 1-64

To change the number of digits for Internal Page Zones:

1. From the Start menu, select Programs - NEC - Telephony Administrator, or double-click on the Telephony 
Administrator icon on the desktop.

2. Click on Telephony Settings. Under the Feature Codes tab, select 0-9 or 00-64 in the Internal Paging Zones section. 

3. Close the Telephony Administrator utility by clicking OK.
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To send a Page:

1. Click the Page icon ( ) OR press the assigned hot key on the keyboard (F9).

2. Select the type of page to be generated: Internal, External, or Combined + select the paging zone within the 
selected category + click Start to initiate the page.

3. Announce the page + click Hang Up to disconnect from the paging system.

Park

Park

Park places a call in a waiting state (called a Park Orbit) so that an extension user may pick it up. The PC Assistant uses 
the System Park option when you want to have the call wait in a system orbit. After parking a call in orbit, the user can 
Page the person receiving the call and hang up. The paged party dials a code or presses a programmed Park key to pick up 
the call. With Park, it is not necessary to locate a person to handle their calls. A call parked for too long will recall the 
extension that initially parked it, however the call remains in the park orbit until it’s answered. There are 64 Park Orbits 
(1-64) available for use.

The PC Assistant also provides an Unpark function in order to retrieve a call from a park orbit.

To Park the active call:

1. Click the Park icon ( ) OR press the assigned hot key on the keyboard (F10).

2. Select the park orbit (1 through 64) within the Park menu + click Start.
If the park orbit is currently occupied, a warning message will be displayed. The Assistant will then be 

reconnected to the caller and allowed to select a different park orbit.
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To retrieve a call using the Unpark function:

1. With the PC Assistant keyset idle, click the Unpark icon ( ) OR press the assigned hot key on the keyboard 

(F11).

2. Select the park orbit (1 through 64) within the Unpark menu + click Start.
If the park location is currently empty, a fast busy signal will be heard.  

Placing a Call

Placing a Call

The PC Assistant provides the Dial function to initiate a call to an internal or external number and special dialing features 
for the Directory tab.

Placing a call using the Dial function

1. Click the Dial icon OR press the assigned hot key (F5) on the keyboard.

2. Enter the number to be dialed in the Destination field within the Data Entry area + press Start.

Placing a call using the Directory 

1. Within the Directory, double-click on the directory entry to be called or press the right mouse button + Dial 
Extension.

- OR --

1. Within the Directory, press the right mouse button on the desired entry + Dial Extension.
Using the Notes option within the Directory, users can advise other PC Assistant or PC Attendant user’s 

of their status. For example, a user can enter a note for their extension such as “Out of the office until Mon-
day”. Anyone then displaying the Directory will be able to see this note for that extension. In addition, for the 
PC Attendant users, hovering over an extension with a note will display the text in a balloon window. The 
ability to edit the Directory must be allowed in the Telephony Administrator for the extension. 

Placing a call using the Contact Manager

1. Display the desired contact in Microsoft Outlook or GoldMine.

2. With Microsoft Outlook: 

Click on the Aspire Dial icon and a list of the possible telephone numbers for the contact is displayed. Select the 
desired number. You can then handle the call through the PC Assistant or end the call using Microsoft Outlook by click 
the Aspire Dial icon again and clicking End Call.

Aspire Dial
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With GoldMine: Open the contact to be called. Click Contact - Dial Phone then select the number to be dialed. The call 
can then be handled through the PC Assistant or through GoldMine.
With ACT!: Open the contact to be called. Click Contact - Phone Contact then select the number to be dialed. The 
call can then be handled through the PC Assistant or through ACT!.

To disconnect from the active call:

3. Click the Hang Up icon ( ) OR press the assigned hot key (F4) on the keyboard.

When an active call is disconnected, the call entry will be removed from the Lamp Indicator Area.

Quick Message Utility

Quick Message Utility

The PC Attendant provides a Quick Message feature which is compatible with PC Assistant users. Quick Message utility 
allows the PC Attendant to send a short text message to another employee. Unlike an EMail message, a Quick Message is 
delivered immediately to the destination and automatically displayed on the user’s PC screen (and optionally hear a beep 
when the message appears). In order to receive Quick Messages, the option must be enabled for the PC Assistant user 
under their application preferences. The recipient can then quickly send a reply back to the attendant by selecting from a 
set of predefined responses. This tool is invaluable for delivering a message to someone who is on the phone or when the 
attendant needs an immediate response. Each user which should be able to receive Quick Messages would need to have 
the Quick Message application installed and the user must be logged in. 

The PC Attendant can easily select the text of the Quick Message from a pre-defined list of standard messages, or com-
pose a short message from scratch. When the message is delivered to the recipient, the message text and standard 
responses are shown on the PC Assistant's PC screen.

When the user selects a response, the reply is sent immediately back to the PC Attendant.

Enable Quick Message for Each PC Assistant User:

1. Click File - Preferences - General tab. 
2. Check Enable Quick Message Client to enable the PC Atten-

dant to send messages to the PC Assistant user. 
3. Check Enable Notification Tone to enable the PC Assistant’s 

PC to beep when a Quick Message is received from the PC 
Attendant. 

4. Click OK.

 Responding to a Quick Message:

1. When the PC Attendant sends a Quick Message, a window pops 
up on the PC screen.

Optionally, you can have the PC beep when a Quick Message is received.

2. Click on one of the response buttons and the PC Attendant receives the reply.
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Transfer

Transfer

Transfer permits an extension user to send (i.e., extend) an active Intercom or outside call to any other extension in the 
system. With Transfer, any extension user can quickly send a call to the desired co-worker. A call a user transfers automat-
ically recalls if not picked up at the destination extension. This assures that users do not lose or inadvertently abandon 
their transfers. While a transferred call is ringing an extension the system can optionally play ringback tone or Music on 
Hold to the caller, based on the Aspire system programming.

The PC Assistant provides several different methods to initiate a transfer on an active call. The Transfer function can be 
used to initiate a transfer to an external or internal number, while the Directory tab provides special features to initiate a 
transfer to an internal extension. The PC Assistant also provides the option to perform either a supervised transfer or unsu-
pervised (blind) transfer.

Transferring a call:

1. Click the Transfer icon ( ) OR press the assigned hot key on the keyboard (F3).

2. Enter the number to be dialed in the Destination field within the Data Entry area.

3. [Supervised Transfer] Click Start to initiate a supervised transfer. When the destination party answers, announce 
the transfer and then select Complete. If the destination does not answer or does not want to take the call, select 
Disconnect to reconnect to the original caller. If the destination is busy or does not answer, select Voice Mail to 
send the call to the destination voice mail box.

-OR-
3. [Unsupervised Transfer] Click Blind to initiate an unsupervised (blind) transfer. The call will be immediately 

routed to the specified destination.

Transferring a call using a directory entry:

This option requires the Directory window be displayed (click FILE-DIRECTORY).

To initiate a supervised transfer using a BLF/DSS key:

1. Press the right mouse button on the desired Directory entry. Select Transfer - Supervised. 

2. When the party answers, announce the transfer + press the Complete button on the Transfer menu.

3. If the destination does not answer or does not want to receive the transfer, either select Voice Mail to send the call 
to the extension’s voice mail or Disconnect in the Transfer menu to reconnect to the original caller.

To initiate an unsupervised (blind) transfer using a BLF/DSS key:

1. Press the right mouse button on the desired Directory entry to receive the call + select Transfer - Immediate. 
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One touch transfers using a directory entry:

This option requires the Directory window be displayed (click FILE-DIRECTORY).

1. Double-click on the desired Directory entry. The transfer will either be an immediate or supervised transfer, based 
upon the current setting in the File-Preferences-Directory menu. When the one-touch transfer initiates a super-
vised transfer, the Data Entry area will become enabled. Select Complete within the Data Entry area to complete 
the transfer or Disconnect to reconnect to the original caller.

Note: The one-touch transfer initiated with a Directory entry can be either supervised or 
unsupervised (blind). The type of transfer is determined by a setting in the prefer-
ences. To change this setting, click on File-Preferences. Then select the Directory 
tab and change the setting for One Touch Transfer.

Transferring a call to Voice Mail from the BLF/DSS area:

1. With an active call, double-click on a busy (green) Directory entry to transfer to that extension’s voice mail. 
The active call will automatically be transferred to the selected user's mailbox.

For this shortcut to be enabled, the File-Preferences-Directory must have the voice mail option selected 
as the current double-click action.

Voice Over

Voice Over

Voice Over lets a user interrupt a keyset extension user busy on another call. With Voice Over, the busy keyset extension 
user hears an alert tone followed by the voice of the interrupting party. The keyset extension user can respond to the inter-
rupting party without being heard by the original caller. If desired, the keyset extension user can easily switch between 
their original caller and the interrupting co-worker. The original caller and the interrupting party can never hear each 
other’s conversation.

Voice Over could help a lawyer, for example, waiting for an urgent call. While on a call with another client, the lawyer’s 
paralegal could announce the urgent call as soon as it comes in. The lawyer could then give the paralegal instructions how 
to handle the situation - all without the original client hearing the conversation.

Either a keyset or 500/2500 set user can initiate a Voice Over, but only a keyset user can receive a Voice Over.

Using Voice Over to a Busy Extension:

1. After calling a busy extension, click thet Voice Over icon ( ) OR  press the assigned hot key on the keyboard 

(ALT-F5) OR with the Directory window displayed (click File-Directory), double-click on the busy extension 
(indicated by a red bullet to the left of the name).

For this shortcut to be enabled, the File-Preferences-Directory menu must have the Voice Over option 
selected as the current double-click action.

- Important -
Do not use Voice Over to a user on speakerphone as the 

conversation may be heard by the outside party.
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